
    
Introduction
POW (Powerline Offline reader for Windows) is a "One QWK at a time" OLR but with the facility to save 
messages to a database divided into Folders.    Replies created with the program are also automatically 
saved into a special folder reserved for this purpose.

To read a QWK mail packet, a list of files is presented from which to choose, with the ability to alter the 
search pattern or directory.    

Having chosen the QWK packet POW calls PKUNZIP to extract the data.    This data is then read and 
internal tables created which are used later to select conference etc.    

If a corresponding REP packet is found in the specified replies directory(see later) it is checked for 
date/time with respect to that of the QWK pkt, and an option provided to delete it if it's earlier ie. the user 
may have already uploaded it.    

If it exists the REP pkt is then unzipped and the replies made available in the reader for viewing or editing.
Replies are rezipped into a REP pkt using PKZIP when a new QWK pkt is chosen to view or on exit.    If 
you are making a lot of replies an option is provided (from the File Menu) to save them back to REP, for 
safety.

POW was written with Microsoft Visual Basic v3.0 Professional Edition and requires VBRUN300.DLL.



The Conference List
This is a list of conferences which contain messages in the current QWK packet.    The fields comprise the
Number, Name, and number of messages.    (In future the number of UnRead messages will also be 
shown).    Personal messages also appear in a special PERSONAL section.

Buttons 
Read Read messages from first in conference (may be sorted by subject)
List List the messages (may be sorted by subject)
Close Close conference list



The Directories Dialog.
This is used to change directory paths or the search pattern used to find QWK packet
files.    The input fields are divided into two sections.    Changes to fields in the top section
will have immediate effect but any changes made in the other will require a program
restart.

QWK File Pattern Search pattern for QWK files - eg. *.QW? or *.Q??
QWK Directory Path to the directory containing your QWK pkts

Replies Directory Path to the directory containing your REP pkts

SaveAs Directory Path to the directory for saving text files and messages.
_____________________________________________________________

Data Directory Directory for the Folders Data and index files

Work Directory Directory for temporary files.    All files in this dir will be deleted on exit or when 
reading a new QWK packet.    The directory itself is removed on exit if on the 
same drive as the EXE.

Click on the Save button (or Alt-S on keyboard) to save these settings.

A file, POW.INI, is created in the Windows directory.    This contains these and other settings/options.    No
changes are made to WIN.INI or any other Windows files.

Once created, you may move POW.INI to the program directory (where POW.EXE is) if you want. 



The Toggles Dialog
Warning Beep Turn warning sounds on/off

Show Progress Boxes Turn Progress Boxes on/off.    Users with fast machines may prefer to 
disable these.

Continue to Next Folder "Next" continues to next folder (or not) when at last msg in folder and 
"Prev" goes back to previous folder from first msg.

Allow Msg Text Editing The Text of an original msg may be edited temporarily.    May be used to 
alter the format for Quoting in a reply.    eg. Splitting a paragraph.

    
These settings may be Saved "Permanently"(in POW.INI) or Temporarily, in which case the change(s) will 
only apply for this run, reverting to the "permanent" settings when POW is next run.



Sort Options
QWK File Sets the order in which the QWK files are listed in the File Open dialog.    Sort on 

Name or Date/Time - Ascending or Descending.

Conf Msg List Sort by Subject or Number(unsorted)

Folder Msg List Sort by Subject or Number(unsorted)

These settings may be Saved "Permanently"(in POW.INI) or Temporarily, in which case the change(s) will 
only apply for this run, reverting to the "permanent" settings when POW is next run.



File Menu
Open QWK Packet Displays Dialog box from which QWK pkt is selected

Save Replies Save Rep pkt back to HD (if one exists)
Kill (Delete) REP Delete REP pkt and any replies held in POW

Save Msg to File Saves Msg to a File (Appends to existing file).    Calls standard File SaveAs 
dialog

Print Msg Prints msg using Font as set up in Printer Font from Options Menu

Exit Reader Save all data and Exit



View Menu
Folders Show list of Folders - select a folder to view

Conferences Show list of conferences
RepPkt List of replies in REP pkt.    See Viewing your Replies.

Bulletins Bulletin list.    Selected Bulletin is shown in Viewing Screen.

NewFiles New Files list (shown in Viewing Screen).
News BBS News (shown in Viewing Screen).

Welcome Welcome (Hello) screen (shown in Viewing Screen).
Goodbye Goodbye screen (shown in Viewing Screen).

Session Text of the Mailrun Session (shown in Viewing Screen).



Options Menu
Directories Set up directories for QWK, REP, Data and temp work
Toggles Enable or Disable features such as warning beep 
Sort Options Sort field etc. for QWK list, Message lists etc.

Font (msgs) Select Font (+Size etc.) for message display.
Printer Font Select the Font used to print text, including Size, Bold etc.
Colors Calls the Color Change Dialog.    Various colors may be Set from a standard 

Windows color dialog.

Maintain Database Displays Folders Database Statistics & Maintenance box from which the Folders 
database file may be packed, purging deleted messages.

Add/Drop Confs    Calls the TomCat Door Control dialog which shows a list of conferences from 
which the user may choose Add, Drop or Reset.    The Reset button has an 
associated Text box into which the message number may be put.    Use a 
negative number to select the last so-many messages to read.



The Font Dialog
Font from the Options Menu brings up a dialog box containing a list of Fonts available on your system 
from which an alternative font may be chosen for the message display in the main window.    The size and
bold may be changed too.    Sample text in the selected font and size etc. is shown so that you can see 
the effect before pressing the OK button to make the changes take effect.    A Cancel button is also 
provided.

This allows the user to choose a bigger or nicer looking font than the default Terminal Font.
However, please note that only Terminal Font will produce the correct format for the message and 
properly display ASCII chars above 128 such as graphics and the pound sign.
Unless, of course, you have another fixed font with the ASCII (OEM) character set.

The selected Font etc. is saved in the POW.INI file and will be used next time POW is run.



Color Change Dialog
This consists of a Color to Change List Box containing a list of colors which may be changed, and 
buttons Set and Cancel/Close.    Select a color to change from this box by clicking on the item or using 
the arrow keys.    Then use the Set button which calls a standard Windows color dialog where you can 
choose a color.    After setting up the colors as desired, the Close button will return to the appropriate 
Window and change the appropriate colors.



Help Menu
Help Contents Display help at the Contents page
Keyboard Use of Keyboard
How to use Help Instructions for using the Windows Help system
Read Documentation Call Write to read the doc
About Program Info



Message Header
The message header box shows the following information:-

Conference NumberDate Time Recvd x of y
From Refer
To Read Saved Reply Private
Subject



Button Bar
Buttons provide the following functions:-

QWK Call the QWK File Open Dialog.

Conf Show the Conference List

REP Shows replies in REP Pkt.    See Viewing your Replies

Fold Shows the Folder List

Art Calls the Viewing Screen to show msg in Text or Picture (ANSI Art).

Tag Copies first line of marked text into a one line text editing box in Tagline Editor dialog.    The 
tagline may be edited before adding it to the Taglines list using the Add button.

Send (REPLIES Folder Only)    Send reply/msg again.    Copies msg from Folder to REP.

Write Enter a new message into the REP pkt.    Calls the Editor. (see also Reply below)

Reply Either marked text or all of the msg is converted to a quote and entered into the internal editor 
where a reply may be written.    Also displayed above the edit box is the reply header.    Certain 
fields of this may be edited or info selected from pick lists.

Edit (Replaces Reply for "REP" or "REPLIES Folder")    Edit reply/msg.

Save Save the message to a folder.    A list of folders is shown from which to choose, or a new folder 
may be created.

Kill (Folders & REP only)    Kill (delete) the current message in the folder or REP pkt.      Msgs marked 
as deleted are not displayed nor count towards the number of msgs in the Folder.    Deleted msgs 
may be purged from the Folders data file using Pack Database from the Folders Statistics & 
Database Maintenance dialog from Options/Maintain Database menu.

Index Displays a list of the messages in the current conference, folder or REP packet.    This also shows
whether a message has been read, saved, or replied to and if private.

Prev Go to previous message in conference/folder/REP if it exists..    In a conference this will go on to 
the previous conference if at the first msg.      An Option provides this feature for Folders also.

Next Go to next message.    In a conference this will go on to the next conference if at the last msg.      
An Option provides this feature for Folders also.

 



Viewing Screen
This is a Window containing a box for viewing text or picture (ANSI colour etc.) plus Option Buttons to 
choose Text or Picture and Colors, File, Print, Stop and Close Buttons.

If Text is selected any ANSI code sequences are stripped from the text and the remaining plain text 
displayed in a scrolling Text Box.

If Picture is selected the ANSI code sequences are obeyed to give colour and cursor positioning and 
displayed in a Picture Box.    Scrolling is available by using the PgUp or PgDn key to page up/down by 
two lines less than the window and the up/down cursor keys to scroll up or down by two lines.    RIP 
graphics files are detected and a warning given.    This version of POW will only display ANSI graphics or 
TEXT.

Colors allows changing the Window and text colors.

File provides the facility to save text to a file via a SaveAs dialog where an existing file may be
selected for Appending or a new file name entered.

Print allows printing a text file using the Font etc. set up in the Printer Font in the Options Menu.

Stop allows the user to stop the display of a Picture before completion.



The Folder List
This is a list of Folders which the user has created plus the special REPLIES folder which contains copies
of replies created with POW.    This is used either to view messages already saved or to select a folder in 
which to save the currently displayed message.

Fields are:- Number, Name, number of messages saved in each folder.

Buttons:-
Read Read messages from first in folder (may be sorted by subject)
List List the messages in the folder (may be sorted by subject)
Save Available when saving message to a folder

Add Add a new folder
Edit Edit the name
Delete Delete all messages in this folder (not yet implemented)

Close Close the Folder List and return to Main Window



Message Lists
A list of the messages may be displayed for either conference, folder or REP pkt.    

The fields are:- MsgNum, From, To, Subject, Flags.    

In the case of the conference list the flag column shows whether the msg has been Read, Saved to folder,
Replied to, or is Private.



The QWK File Open Dialog
This Dialog is used to select a QWK mail packet for viewing (or deleting).

A table gives the following information:-
    Filename 
    Size 
    Date & Time 
    % Read     (of messages)
    Number of Personal msgs
    Number of msgs Replied to

The directory and drive may be changed in the usual way and also the file search Pattern.    This uses the 
usual DOS wildcards.    To change settings "Permanently" use the Directories Dialog from the Options 
Menu

To select a file select it and click on OK or double-click on the table entry.

Buttons:-
OK Read selected QWK pkt or enact change of Pattern, Directory or Drive.

Update Update file list (if you've altered things by switching out to File Manager etc.)

Hide Hides selected file by renaming to BBSID.!01.    Where BBSID is the name the BBS uses 
for QWK & REP pkts.    Earlier renamed files are renumbered to make room - up to 99.    
When 99 files have been renamed/renumbered the BBSID.!99 file is deleted and all 
others moved up.

Kill Kill (Delete) selected QWK file.

Cancel Return to Main Window.



Replying to Messages (and creating new ones)

You may create a Reply to a message showing in the main window.    Using the mouse or keyboard, mark
the text you wish to quote, then click on the Reply button or press the R key.      The built-in Editor is then 
loaded and the selected text will be displayed in the Edit Box, reformatted if necessary and with leading 
Quote markers at the beginning of each line.    The text cursor is placed below the quoted text.

As an alternative, you may "quote" the whole original message into the editor and then delete parts not 
needed.    This occurs if no text is selected (marked).    The Reply button or R key will invoke the Editor as
above.

To create a new message or reply without quoting from the original, click on the Write button or press the 
W key to call the Editor.

Text may now be entered and edited using all the usual Windows editing functions.    See The Internal 
Editor for more information.



Saving Replies
Having created your msg/reply as above it is saved to a Replies file for adding to the REP pkt later and 
also copied to the REPLIES Folder, from where it may be recovered if required and re-sent (Send) or 
edited as the basis of another message.    This is achieved by selecting Save & Exit from the Editor File 
Menu.

If you want to send the same or similar message to more than one person you may select Carbon Copy 
from the Editor File Menu, which saves the message as above but remains in the Editor.    The recipient's 
name (and any other particular) may then be changed and the message saved as above.    To send to 
several people use the Carbon Copy as required.

Replies created with the Replies Editor are packed into a REP packet file when a different QWK packet is 
selected for viewing or when Exiting the program.    Also, a menu option is provided to let the user save 
replies to the REP pkt at any time (for peace of mind when making a lot of replies).    See also Viewing 
your Replies



Viewing your Replies
Replies either already in the REP pkt or waiting, may be viewed from either the View Menu or the REP 
Button on the Button Bar.    A list is displayed from which a reply may be selected for viewing.    Once the 
message is displayed, it may be edited and saved back if desired.



The Main Menu
      File
      View
      Options
      Help



The TomCat Mail Door Control dialog
This shows the complete list of conferences available on the BBS (at the time the QWK packet was 
created) from which the user may choose Add, Drop or Reset.    The Reset button has an associated 
Text box into which a message number may be put.    This is the message number from which to start.    If 
you want to read the last N messages without knowing the current msg number then use a negative 
number.
    eg. -50 will select the latest 50 messages to read in the next QWK pkt.

Only the TomCat mail door is currently supported.

If you have the Session Text feature enabled and present in your QWK pkts, this may be checked to see 
which conferences you have currently enabled on the BBS.    Use Session from the View Menu to view it.



The Folders Database Statistics & Maintenance Window
This displays Folders database information and provides buttons for showing the QWK File Info and 
accessing the Pack Database feature.

The following info about the Folders Database is displayed    :-

Number of Folders.
Total msgs in Folders (excluding deleted msgs).
Msgs in REPLIES Folder.
No. of Deleted msgs.

The disk space used is also shown:-

Size of Folders Data file
Bytes used by index (.FDX) files.    (And number of index files)
Estimated extra disk space required to Pack the database.

The QWK File Info shows the information that POW has accumulated about the QWK packets read.    
This includes the BBS ID, Date/Time of file, No. of msgs in pkt, % msgs read, No. of Personal msgs, No. 
of msgs Replied to.    This data is stored in the BOOKMARK.POW file in the Data Directory.

Pack Database reads the Folders data file and removes all messages marked as deleted, closing up the 
gaps and building a new file.    At the same time, the Folders index (.FDX) files are rebuilt from info in the 
Folders Data file.
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APPENDIX A - Limits

Number of QWK Files . . . . . . . .         200
Size of QWK files . . . . . . . . . .       4Mb
Conferences per QWK pkt . . . . 10,000
Highest Conference Number . . .      9999
Messages per Conference . . . .     1,000
Messages per QWK pkt    . . . . . 10,000
Messages per REP pkt    . . . . . .     1,000
Characters per Message . . . . . 30,000
Bulletins per QWK pkt . . . . . . .     1,000
Characters per Bulletin . . . . . . 30,000

Number of Folders . . . . . . . . . .     1,000
Messages per Folder . . . . . . . .     1,000



APPENDIX B



    

Main Window Keyboard Usage

Underlined letters on the Button Bar indicate keys to press as an alternative to clicking on the button with 
the mouse.

PgDn/PgUp keys page down and up in msg.

Space bar pages down till the bottom of the msg then goes to next msg (same as Next button).

Note:-The focus has to be in the msgs box for the space bar to do this - if focus is on a button, the space 
bar presses that button.



Tagline Editor

An edit text box and 2 buttons.

Clicking on Tag on the Button Bar (or pressing T) copies 1st line of selected text in msgs box to a one line
edit box, where tagline may be edited.    Add to Taglines List or Cancel to abort, and return to Main 
Window.
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Windows Keys

The keyboard topics below come from Help for Windows.    Choose from the following list to 
review the keys used in Windows:
Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function

DIRECTION key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or CTRL+Left Arrow Moves to the beginning of a field.
PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter matches 

the one you type.
DIRECTION key Moves from option to option within a group of options.
ENTER Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

ESC Closes a dialog box without completing the command. (Same as
Cancel)

ALT+DOWN ARROW Opens a drop-down list box.
ALT+UP or DOWN ARROW Selects item in a drop-down list box.
SPACEBAR Cancels a selection in a list box.

Selects or clears a check box.
CTRL+SLASH Selects all the items in a list box.
CTRL+BACKSLASH Cancels all selections except the current selection.
SHIFT+ DIRECTION key Extends selection in a text box.
SHIFT+ HOME Extends selection to first character in a text box.
SHIFT+ END Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type.
Alt+letter key Pulls down the menu whose underlined letter matches the one 

you type.
LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left 
or right.

SHIFT+DOWN or UP Selects one line of text up or down.
SHIFT+END Selects text to the end of the line.
SHIFT+HOME Selects text to the beginning of the line.
SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

SHIFT+PAGE UP Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.
CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or 

end (DOWN ARROW) of the paragraph.
CTRL+SHIFT+END Selects text to the end of the document.
CTRL+SHIFT+HOME Selects text to the beginning of the document.



Window Keys

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+ENTER Switches a non-Windows application between running in a 

window and running full screen.
DIRECTION key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.





    
Keyboard

The usual Windows key functions apply to POW.    See Windows Keys.        

When viewing messages, keys corresponding to the underlined letters on the Button Bar activate 
the appropriate functions.    There is no need to use the Alt key in this case.

PgDn/PgUp keys page down and up in msg.

Space bar pages down till the bottom of the msg then goes to next msg (same as Next button).

Note:-The focus has to be in the msgs box for the space bar to do this - if focus is on a button, 
the space bar presses that button.
 
Menu functions are accessed by Alt plus letter key in the usual way.    



Registration Details Dialog 
This is accessed from the Shareware Registration Reminder Screen at startup from the Enter Reg Code 
button.

When you register Powerline Offline reader for Windows you quote the name which you would like 
displayed as your Registered Name and you will be given a Registration Code to enter into the POW 
Registration Details Dialog.

The Registration Details Dialog consists of two text boxes and two buttons.    Enter your Registered 
Name and Registration Code in the text boxes exactly as specified.    

Press OK to make POW check the details.    If the code has not been entered correctly an error message
is displayed and the entry must be re-edited or choose Cancel to close and return to the Shareware 
Registration Reminder Screen.



Registration & Contact Details - Benefits of Registering
To register Powerline Offline reader for Windows print out and complete the registration form 
REGISTER.TXT (this may be done from within POW from a Shareware Registration Reminder) and send 
to:-

UK/Europe
Cheque or Postal Order for £20 plus VAT (£23.50) made out to:-

Powerline Systems Ltd
44 Rydal Way
Ruislip
Middx.
HA4 ORU
ENGLAND

USA/Canada
Check/Money orders for $35(US) made out to:

Southland Trading Company
900-91 Howard Avenue
Escondido
CA. 92029
USA

Support may be obtained by contacting the author, Gina Davis, via the Direct Line BBS, London.    Call 
081 845 8228 (10 Lines) - 8/N/1 - All speeds - Ansi or RIP terminal recommended. 

Support may also be obtained via UKCOMP on CompuServe, address messages to Gina Davis on 
Compuserve ID 70374,1277

For site registration or marketing related information please contact Powerline Systems at the address 
above, or via a Direct-Line message to 'Sysop', or a message on CompuServe's UKCOMP forum 
addressed to Steve Manners on CompuServe ID 70007,4737

Benefits of registering POW include removal of the Registration Reminders and your Registered 
Name appears in the About window.    Also, registered users receive highest priority for requests for 
improvements.    Income from registrations enables continued support and development of POW.    

See ReadMe.Txt for last minute changes and further information.

Disclaimer
This is the first Shareware version of POW.    It has been in Beta Test for several months and bugs 
corrected when found, but no guarantee is given or implied that there are no further problems waiting to 
be found.    Please report any problems to the author (see above).    Any feedback is much appreciated.

POW - Powerline Offline Reader for Windows - Version 1.0.
Copyright (c) 1993 Gina Davis & Powerline Systems Ltd.    All rights reserved.



    
ANSI Code Sequences
These are special sequences of characters which in the right circumstances can chang the colour 
of text or move the cursor around the screen.    Also known as "Escape Sequences" because they 
start with an Escape code.



    
The Internal Editor
An editor is provided in which to create replies or enter new messages.    In addition to a text editing box, 
the message header is also displayed with the option to change certain fields.    These are To, Subject, 
Conference & Tagline.

The To, Subject and Tagline fields have associated "Pick Lists".    New items may be added to a list by 
clicking on the adjacent Add button, or an existing item may be selected from the drop-down list.    The 
text in these fields may be edited in the usual way.

The Conference may be changed by selecting from the drop-down list.

Check boxes may be used to make the message PRIVATE or Request Return Receipt.

When finished the message may be saved to the REP pkt from the Menu.



Editor Menu
File Carbon Copy (no exit), Save & Exit or Exit Editor (Abort - no save).

Edit This provides Windows Clipboard functions plus Undo and Select All, and access to the 
Signatures dialog box.

Help Shows the appropriate Help sections.



Editor File Menu
Carbon Copy Saves the message without leaving the Editor.    This allows the To name to be changed 

and the message saved again if the same or similar message is to be sent to more than 
one person.    For more than two recipients, the Carbon Copy feature may be used as 
often as required.

Save & Exit Saves the message and exits the Editor.    This is the normal means of saving messages.

Exit Editor Leaves the Editor without saving, providing an Abort message facility.    If a message has 
been edited and not saved (with Carbon Copy), a warning message is displayed, with the
option to return to Editor.



Edit Box
When the editor is first entered from the Reply button, either selected text or the complete original 
message is reformatted and quoting characters added to the start of each line.    The text cursor is placed 
below the quoted text.    If a new message is to be created (from the Enter button) the Edit Box is empty, 
ready for the text of the new message.

In entering text all the usual Windows editing functions are available.    Text may be cut/copied/pasted 
to/from any other window including other Windows apps or another window in the Reader (eg. the original
msg).    Most of this information is in the Windows manuals or in the on-line Help (see Keyboard).    
Terminal font is used to provide compatibility with other message readers (uses the ASCII char set as 
opposed to the Windows ANSI set).

NOTE:- This editor (and message viewer) supports the Tab function.    (Use Ctrl+Tab to insert a Tab - the 
Tab key alone changes field).    Some other readers do not support the Tab character and other users may
not receive your message correctly formatted.



The Signatures Dialog
The signatures features provides the facility to have multiple "signature blocks".    These are blocks of text
held in files which may be appended to the message.    These are normally used to "sign" a message with
extra bits such as Internet address, where you live etc., but any text may be used.    (Even a whole msg if 
you like as an alternative to the Carbon Copy feature.)

The dialog box contains an editing Text Box with option buttons to select the source of the text, a Table 
of Signature Files listing the files available with descriptions, a Description box and buttons for Save, 
Paste & Close.

Text in a msg currently in the Edit Box in the Editor may be marked for use as a "signature block" and be 
copied into a text box in the Signatures Dialog, or new text may be entered directly.

Having copied or entered text into the Text Box and entered a Description, the text may be saved to disk
using the Save button.    A text file is created in the Data Directory.

Blocks of text saved in this way (or created using another editor if you like) may be viewed in the Text 
Box and inserted at the end of the message in the Editor's Edit Box using the Paste button.    A signature 
block may also be entered by using keys F2 to F10 whilst in the Editor.    These keys are listed in the 
Table of Signature Files with the description.    Note, F1 is used for on-line help.




